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I. Einleitung 

Herzlichen Glückwunsch zum Erwerb der SoundTrack Audio DSP24. Die Audio DSP24 ist eine 
Audiokarte auf PCI-Basis, die in der Lage ist, als selbständige Schnittstelle einer Vielzahl von 
externen Erweiterungen von Hoontech für die Audioaufnahme und –wiedergabe zu arbeiten. 

Es gibt zwei Hardware-Versionen der SoundTrack Audio DSP24. Während die reguläre Version 
in der Regel zusammen mit externen Wandlerboxen verwendet wird, stehen bei der SoundTrack 
Audio DSP24 MK II bereits zwei analoge Ein- und Ausgänge mit 24bit/96kHz Wandlern auch 
ohne externe Wandlerbox zur Verfügung. Nahezu alle Hinweise in diesem Handbuch beziehen 
sich gleichermaßen auf beide Hardware-Versionen. 

Folgendes sollten Sie bei der Lieferung Ihrer Audio DSP24 erhalten haben: 

• Hoontech SoundTrack-Audio-DSP24-PCI-Soundkarte 

• Digitale XG-DB-I-I/O-Karte 

• 4x4-pin S/PDIF-I/O-Kabel 

• 2x2-pin CD-ROM-Digitalkabel 

• 4x3-pin CD-ROM-Analogkabel 

• Treiber und Installations-CD-ROM 

• Emagic Logic SoundTrack24 CD-ROM 

• englischsprachiges Handbuch 
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Hervorragende Qualität: 

Die Audio DSP24 unterstützt bis zu 24-bit-Auflösung und 96 kHz Samplerate und enthält eine 
digitale Erweiterung, die über AES/EBU- sowie optische und koaxiale S/PDIF-Anschlüsse 
verfügt. Die Audio DSP24 kann bis jeweils zu zehn Ein- und Ausgänge bewältigen, wenn sie in 
Verbindung mit der Tochterkarte benutzt wird – und das alles bis zu 24 bit und 96 kHz.  

Insgesamt werden alle internen Signalwege bei 36-bit-Auflösung verarbeitet, was Ihnen die 
höchste Auflösung und optimale Dynamik garantiert. 

Erweiterungsmöglichkeiten: 

Sie können bis zu vier Audio DSP24-Soundkarten in einem System verwenden. Dazu sind keine 
Jumper erforderlich. 

Die Audio DSP24 kann an eine oder mehrere externe 19“-Anschlußboxen (H-BUS) 
angeschlossen werden, wie zum Beispiel: 

ADC III – 24bit/96kHz, 8 analoge symmetrische Eingänge, Line-in-Vorverstärker und 
Mikrofoneingang mit 48V Phantomspeisung für Kondensatormikrophone. 

DAC III – 24bit/96kHz, 8 analoge symmetrische Ausgänge, AES/EBU, optische and koaxiale 
S/PDIF-Verbindungen sind ebenfalls verfügbar. 

Digital Modulator III – 24bit/96kHz, S/PDIF und AES/EBU I/O-Verbindungen werden 
unterstützt. Die Eingänge werden automatisch synchronisiert. 

ADC&DAC2000 – 24bit/96kHz, 8 unsymmetrische Ein- und Ausgänge, 2 XLR-Eingänge mit 
Lautstärkeregelung, Kopfhörer-Ausgang mit Lautstärkeregler und MIDI I/O. 

Digital Station 2000 – 8-Kanal-ADAT- und TDIF-I/O-Schnittstelle. 

Es ist natürlich möglich, verschiedene externe Erweiterungen gleichzeitig an eine Karte 
anzuschließen, damit Sie ein System mit exakt so vielen Ein- und Ausgängen aufbauen können, 
wie Sie es im Moment benötigen. 

Intiutive Software und Treiber: 

Die Audio DSP24 ist ausgestattet mit verschiedenen Treibern und Anwendungen. 

External Links ist die Audio DSP24 Steuerzentrale und macht es Ihnen möglich, Signalwege für 
eine Reihe von Geräten auf einer virtuellen Patch Bay festzulegen oder zu verändern. 
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Der External Mixer (mit 20 Kanälen) hat Regler für die Ein- und Ausgangssignale sowie für die 
Balance für die Wave-1/2-, Wave-3/4-, Wave-5/6- und Wave-7/8-Kanäle, (jeweils paarweise in 
Stereo), einen S/PDIF-Ein- und Ausgang - sowohl während der Aufnahme als auch beim 
Abmischen. Der Output des External Mixers kann entweder über externe Erweiterungen 
abgespielt werden oder - digital - über die XG DB I Erweiterung. 

Der Internal Mixer verfügt serienmäßig über Ein- und Ausgangs-Regler für Wave, Line-In sowie 
für den Mikrophon-, CD- und den Aux-Eingang. Das Ausgangs-Signal des Internal Mixers wird 
immer über den Line-Output der Karte abgespielt. 
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II. Technische Daten 

• PCI 2.1- Schnittstelle 

• 10 Ein- und 10 Ausgangskanäle, die über XG DB I und externe Erweiterungen (External 
Mixer über das H-BUS Interface) genutzt werden 

• unterstützte Sampleraten in kHz: 32, 44.1, 48, 88.2 und 96 

• unterstützte Wandler-Auflösung: 16-bit, 20-bit und 24-bit 

• MPU-401 MIDI Schnittstelle 

• interner CD-Eingang, Line-in, Mikrofoneingang, Line-Out über AC-97 Codec (Internal 
Mixer) 

• AES/EBU sowie optische und koaxiale S/PDIF-Schnittstelle 

• Kompatibel mit SoundTrack Digital Audio 

• Kompatibel mit Windows 95/98/ME, NT4 und Windows 2000 

• Unterstützung für ASIO 2.0 

• GSIF (GigaSampler-Interface) 
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III. Anschlüsse 

SoundTrack Audio DSP24 

 

1. Mikrofoneingang – Miniklinke 

2. Line-In – Stereo-Miniklinke 

3. Line Out – Stereo-Miniklinke 

4. H-BUS-Anschluß (digitale I/O-Verbindung über 44x44 pin Kabel für externe Erweiterungen) 

5. 16 pin Stecker für optionale Digital I/O-Erweiterung oder Analog Bracket 

6. MIDI Stecker (Kabel optional) 

7. Digital Audio Stecker – wird zur Kaskadierung mit der SoundTrack Digital Audio verwendet 

8. CD-Eingang – kann an den analogen Output des CD-ROM-Laufwerks angeschlossen werden 

9. Aux-Eingang – kann an den analogen Output einer TV-Karte oder andere analoge Quellen 
angeschlossen werden 

10. S/PDIF I/O – Verbindung zur XG DB I Tochterkarte 

11. CD Eingang – kann mit einem digitalen CD-ROM-Laufwerk verbunden werden (nicht 
funktionsfähig, wenn S/PDIF aktiv ist und umgekehrt) 
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SoundTrack Audio DSP24 MK II 

 

1. 15pin D-SUB Anschluß für Kabelpeitsche (4x XLR, 1x Miniklinke) 

2. H-BUS-Anschluß (digitale I/O-Verbindung über 44x44 pin Kabel für externe Erweiterungen) 

3. Jumper zur Kontrolle der Miniklinkenbuchse (Ausgang) 

4. 16 pin Stecker für optionale Digital I/O-Erweiterung oder Analog Bracket 

5. CD-Eingang – kann an den analogen Output des CD-ROM-Laufwerks angeschlossen werden 

6. Aux-Eingang – kann an den analogen Output einer TV-Karte oder andere analoge Quellen 
angeschlossen werden 

7. CD Eingang – kann mit einem digitalen CD-ROM-Laufwerk verbunden werden (nicht 
funktionsfähig, wenn S/PDIF aktiv ist und umgekehrt) 

8. S/PDIF I/O – Verbindung zur XG DB I Tochterkarte 



SOUNDTRACK Audio DSP24 

- 9 - 

IV. Block Diagramm 

 

Hinweis: Internal und External Mixer arbeiten völlig unabhängig voneinander. Der Internal 
Mixer kontrolliert normale PC-Audiofunktionen, wie zum Beispiel Windows-Sounds oder 
CD-Audio- Playback. Der External Mixer wird von Recording-Anwendungen unabhängig davon 
verwandt und unterstützt bis zu 24 bit/96 kHz. 

Mikrofoneingang, Line-In, Line-Out, sowie die Aux- und CD-Eingänge werden durch die AC-97 
Codec der Audio DSP24 betrieben und durch den Internal Mixer kontrolliert. 

Die digitalen Ein- und Ausgänge stehen über die XG-DB I Tochterplatine zur Verfügung. Die 
Signale der DSP24 können intern oder extern synchronisiert werden. Die Standardeinstellung 
liegt bei 44.1kHz. 

Bis zu vier externe AD- und DA-Wandler können von der Audio DSP24 verarbeitet werden. Die 
Ein- und Ausgänge dieser externen Erweiterungen sind an den External Mixer angeschlossen. 
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V. Hardwareinstallation 

Vergewissern Sie sich, daß der Computer ausgeschaltet und ausgesteckt ist. Entfernen Sie die 
äußere Gehäuseabdeckung. Prüfen Sie, ob Sie die Audio DSP 24 und die XG DB I korrekt, d.h. 
wie oben beschrieben, angeschlossen haben. Stecken Sie die Audio DSP 24 PCI-Karte nun in 
einen freien PCI-Steckplatz, wobei Sie bitte sicherstellen, daß sie richtig (fest!) an ihrer 
vorgesehenen Position sitzt. 

Das Audio DSP 24 System besteht aus der Haupt-(PCI-)Karte (Audio DSP24) und einer 
untergeordneten Tochterkarte (XG DB I). Stecken Sie bitte das graue Kabel in die CNN2 
Verbindungsbuchse an der Audio DSP24 und dann in die Tochterkarte, um die beiden Karten 
miteinander zu verbinden. 

 

Sie können sowohl den analogen als auch den digitalen Ausgang Ihres CD-ROM-Laufwerks 
anschließen. Der digitale CD-Ausgang kann entweder an die CNN3-Verbindungsbuchse der 
Audio DSP24 angeschlossen werden, oder an die als J3 markierte Buchse auf der XG DB I. Der 
analoge CD-Ausgang sollte an die CON1-Verbindungsbuchse der Audio DSP24 angeschlossen 
werden. Alle hierzu benötigten Kabel liegen bei. Bitte überprüfen Sie bei ihrem 
CD-ROM-Hersteller/Ihrer Gebrauchsanweisung, ob Ihr Gerät digitalen Ausgang unterstützt. 

Wenn Sie die DSP24 MK II besitzen, verbinden Sie bitte die mitgelieferte Kabelpeitsche mit dem 
15pin D-SUB-Stecker der Karte. 

Anschluß der externen Hardware 

Externe Wandler werden an die Audio DSP24-Karte über das dem System beiliegende, dicke 
cremefarbene 44-pin Kabel angeschlossen. Alle externen Wandler und optionalen Erweiterungen 
können über die DATA-In- und DATA-Out-Anschlüsse (H-BUS) kaskadiert werden.. 
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Um die erste externe Erweiterung anzuschließen, (wie zum Beispiel eine ADC & DAC2000), 
gehen Sie bitte folgendermaßen vor: 

Verbinden Sie das lange, dicke cremefarbene 44 pin Kabel vom Anschluß auf der Rückseite der 
Audio DSP24 mit DATA-Out bei der externen Erweiterung. 

 

Achtung: Sie dürfen niemals das 44-pin Kabel ein- oder ausstecken, solange der Computer nicht 
heruntergefahren und ausgeschaltet wurde. 

DIP-Switch-Schalter – Sie brauchen einen Schalter in der oberen Stellung. Es gibt zehn DIP 
Switch-Schalter an der Seite jeder externen Erweiterung (mit Ausnahme des DAC III). Die untere 
Stellung steht bei allen Schaltern für ‚aus’. Die obere Position steht bei allen Schaltern für ‚ein’. 
Die Schalter 1-4 regeln die einzelnen spezifischen IDs der Softwareeinstellungen. Sie sind 
notwendig, damit das System verschiedene AD-Wandler oder andere externe Erweiterungen 
unterscheiden kann., wenn verschiedene Geräte an eine Karte angeschlossen werden. Einer dieser 
Schalter muß also auf ‚ein’ stehen (oben). 

Bis zu vier externe Geräte können also gleichzeitig an die Audio DSP 24 angeschlossen werden. 
Ein Beispiel wäre etwa ein System mit einer ADC & DAC2000 (8 analoge Ein- und Ausgänge) 
und der Digital Station 2000 (ADAT und TDIF I/O). 

Bedenken Sie, daß jede Erweiterung eine spezielle ID-Nummer hat. Wenn Sie also eine zweite 
Erweiterung anschließen möchten, muss die ID der Erweiterung , die von dem DIP-Schalter auf 
der rechten Seite kontrolliert wird, eine andere sein. Nachdem sie die korrekte DIP-Schaltung 
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eingestellt haben, schließen Sie die zweite Box an. Verwenden Sie dazu das mitgelieferte 
cremefarbene 44-pin-Kabel, verbinden Sie DATA der ersten externen Erweiterung mit dem 
DATA-Anschluß der zweiten. 

In Kapitel X finden Sie weitere Informationen über verschiedene externe Erweiterungen und 
andere Erweiterungsoptionen der SoundTrack Audio DSP 24. 

Wenn alles an die Karte angeschlossen ist, können Sie Ihren PC starten und mit der Treiber- und 
Softwareinstallation fortfahren. 
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VI. Treiber- und Softwareinstallation 

Installation der Treiber 

Der Audio DSP24 liegt eine CD bei, die die Treiber für Windows 95/98/ME und NT4/2000 
enthält. Achtung: die folgenden Instruktionen beziehen sich nur auf Windows 98. Die Installation 
unter Windows ME verläuft sehr ähnlich. 

Nach dem Anschluß der Audio DSP24 an den PCI-Steckplatz des Computer starten Sie das 
System. Windows 98 wird die neue Hardware identifizieren und folgendes Fenster anzeigen. 

 

Klicken Sie Weiter. 
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Wählen Sie Suche nach dem besten Treiber und klicken Sie Weiter. 

 

Kreuzen Sie Nach bestem Treiber suchen an. Geben Sie <laufwerksbuchsta-
be>:\sound\dsp24\driver in das Textfeld darunter ein und klicken Sie Weiter. Alternativ können 
Sie über Durchsuchen den Treiber auf der CD manuell suchen. Klicken Sie dann Weiter. 
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Wenn Windows den Treiber gefunden hat, sollten Sie das oben abgebildetete Fenster sehen, den 
Name des Treibers können Sie auf den Screenshot erkennen. Klicken Sie Weiter. 

 

Mit diesem Fenster komplettieren Sie die Installation, indem Sie auf Fertigstellen klicken. 
Windows installiert jetzt den Treiber für Sie in einer Abfolge von Installationsfenstern. 
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Nachdem der Treiber installiert ist, versichern Sie sich, ob die Installation auch arbeitet. Wählen 
Sie dazu Start>Einstellungen>Systemsteuerung>Gerätemanager>Audio-, Video- und 
Game-Controller. Sie sollten nun Ihre DSP24 dort aufgelistet finden. Markieren Sie sie mit der 
rechten Maustaste und klicken Sie auf Eigenschaften. Jetzt sollte die Information erscheinen: Das 
Gerät ist betriebsbereit. Klicken Sie dann auf Resourcen. Jetzt sollte die Information erscheinen: 
Keine Konflikte. Wenn dem so ist, haben Sie den Treiber Ihrer Audio DSP24 erfolgreich 
installiert, Gratulation. 

 

Installation der Software 

Nachdem Sie den Treiber gemäß der Anleitung oben erfolgreich installiert haben, muß die 
Software installiert werden. Legen Sie dazu die Installations-CD in Ihr Laufwerk ein. Wählen Sie 
Start>Ausführen und geben Sie in das Textfeld <laufwerksbuchstabe>:\sound\dsp24\setup.exe 
ein. Klicken Sie OK. 
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Sie sehen das SoundTrack-Setup-Logo, und die Windows-Setup-Anzeige erscheint: 

 

Als nächstes erscheint das Welcome to SoundTrack Setup Fenster: 
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Klicken Sie: Next. 

 

Wählen Sie das vorgeschlagene Verzeichnis, indem Sie Next klicken oder wählen Sie ihr eigenes, 
indem Sie Browse klicken und dann Next. 
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Bestätigen Sie den angebotenen Namen des Programmordners (im Starmenu), indem Sie Next 
klicken, oder geben Sie Ihren eigenen ein und klicken Next. 

 

Jetzt sehen Sie die SoundTrack Audio DSP24 Installationsanzeige wie hier abgebildet: 
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Als nächstes erscheint ein Fenster, das die Komplettierung des Setup anzeigt und Sie fragt, ob Sie 
External Links starten möchten. Klicken Sie Finish, falls Sie beenden wollen und das Programm 
starten möchten. Deaktivieren Sie den Launch External Links-Schalter, wenn Sie das nicht 
möchten, und klicken Sie auf Finish. Gratulation! Nun haben Sie die SoundTrack Audio 
DSP24-Software erfolgreich installiert. 
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VII.External Links 

Das Programm External Links ist die Schaltzentrale des Audio DSP24-Systems. Während der 
Installation wurde ein Symbol zur Taskleiste hinzugefügt. Klicken Sie mit der rechten Maustaste 
auf das Symbol, und das unten abgebildete Menu öffnet sich. 

  

 

Wenn Sie Open External Links anklicken, wird External Links gestartet. 

 

Mit External Links können Signale auf ganz unterschiedliche Art und Weise gesteuert werden. 
Zum Beispiel kann der Anwender den Signalverlauf für die Wiedergabe, die eingehenden Signale 
und für die Einzelausgänge festlegen. 

Bitte beachten Sie die folgende Beschreibung zusammen mit der Abbildung von oben: 
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1. External Mixer: Hier wird der External Mixer gestartet. Über den Mixer können Sie alle 
ein- und ausgehende Signalen für das Monitoring in der Lautstärke ändern. 

2. Card No.: Falls mehrere Audio DSP24 Karten benutzt werden, wird die aktive Karte 
hier hervorgehoben angezeigt. Um die gerade aktive Karte zu wechseln, klicken Sie auf 
eine entsprechende andere Kartennummer. 

3. Clock: Hier wird angezeigt, ob die Karte selbst für die Synchronisation verantwortlich 
ist (Internal Master Clock) oder ob das von einem externen Gerät am digitalen Eingang 
(External Master Clock) erledigt wird. 

4. DAC (digital to analog converter – entspricht den Ausgängen): 

• Output 1/2 (Front), Ausgang zu den Front-Lautsprechern (falls Sie einen 
Digitalverstärker benutzen) oder zu Output 1/2 (stereo) des externen Wandlers. 

• Output 3/4 (Rear), Ausgang zu den Rear-Lautsprechern (falls Sie einen 
Digitalverstärker benutzen) oder zu Output 3/4 (stereo) des externen Wandlers. 

• Output 5/6, Ausgang 5/6 (stereo) des externen Wandlers. 
• Output 7/8, Ausgang 7/8 (stereo) des externen Wandlers. 

5. S/PDIF In: S/PDIF-Signal von der XG DB I Tochterplatine. Dieses Signal können Sie 
aufzeichnen, indem Sie das Device ADSP24 S/PDIF In (n) benutzen. 

6. Wave S/PDIF Out: Falls Sie Audiodaten durch den digitalen Ausgang ausgeben 
möchten, wird das Signal hier ausgegeben. Sie müssen dazu das Device ADSP24 
S/PDIF Out (n) verwenden. 

7. Input 1/2 bis 7/8: Das Digitalsignal von den externen Erweiterungen wie z.B. die ADC 
& DAC 2000 oder Digital Modulator III wird über eine Eingangsnummer hier 
angeschlossen. Sie können diese Signale aufzeichnen, indem Sie die Devices ADSP24 
Ext. (n) Input1/2 etc. verwenden. 

8. WaveOut 1/2 bis 7/8: Das abgespielte Signal aus Ihrer Anwendung (von den Devices 
ADSP24 Ext. (n) oder WaveOut1/2, etc.) 
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VIII. Mixersoftware 

Internal Mixer 

Wenn Sie auf Call Internal Mixer klicken, wird der Internal Mixer gestartet. 

 

Der Anwender kann die internen Komponenten des Systems mit dem Internal Mixer 
kontrollieren. Ein- und Ausgangs-Pegel, sowie Stummschaltung und Balance können mit diesem 
Mixer geregelt werden. Bitte werfen Sie einen Blick auf die folgenden Abbildungen, um sich 
einige Details zu vergegenwärtigen. 

Master 

Steuert die Ausgangslautstärke des Internal Mixer. Das Signal aus diesem Mixer wird über den 
Line-Out auf der PCI-Karte selbst ausgegeben. 

 

Balance, Stummschaltung und Lautstärke können verändert werden. 
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Wave 

Steuert die Lautstärke des Device ADSP24 Int. WaveOut (n). 

 

Balance, Stummschaltung und Lautstärke können verändert werden. 

Record 

Wenn ein Signal des Internal Mixer aufgezeichnet werden soll (über das Device ADSP24 Int. 
Input (n)), kann es hier ausgesteuert werden. 

 

Über das Auswahlmenu können Sie den Eingang (die Aufnahmequelle) auswählen. 

Microphone 

Steuert den Mikrofon-Eingang des DSP24 Karte (auf der PCI-Karte selbst). Bitte beachten Sie, 
daß die DSP24 MK II über keinen Mikrofoneingang verfügt. 
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Das Signal kann auch um +20dB zusätzlich verstärkt werden. 

Line In 

Steuert den Line-Eingang des DSP24 Karte (auf der PCI-Karte selbst). Bitte beachten Sie, daß die 
DSP24 MK II über keinen Line-Eingang verfügt. 

 

Balance, Stummschaltung und Lautstärke können verändert werden. 

CD In 

In dieser Abteilung kann die Lautstärke des internen analogen CD-Eingangs geregelt werden. 
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Balance, Stummschaltung und Lautstärke können verändert werden. 

Aux 

 In dieser Abteilung kann die Lautstärke des internen analogen Aux-Eingangs geregelt werden. 

 

Balance, Stummschaltung und Lautstärke können verändert werden. 

Wenn mehrere DSP24 Karten im System installiert sind, können Sie die entsprechende Karte über 
das Pull-Down Menu des Internal Mixer auswählen. 
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External Mixer 

Verwenden Sie den External Mixer, um die Lautstärke und die Balance aller Ein- und 
Ausgangssignale von externen Wandlern (und Digital I/O) zu kontrollieren: 

 

Achtung: Der External Mixer verändert nur das Monitor-Signal (d.h., was Sie hören). Die 
Wiedergabe erfolgt wahlweise über Output 1/2 und/oder den S/PDIF-Ausgang (je nach 
Einstellung in External Links). Bei der Aufnahme hat der External Mixer keinen Einfluß. Dadurch 
wird sichergestellt, daß bei der Aufnahme keine Veränderung (=Verschlechterung) der Qualität 
erfolgt. 

Master 

Steuert die Ausgangs-Lautstärke des External Mixer. Das gesteuerte Signal wird entweder über 
Output 1/2 oder über S/PDIF-Out abgespielt. 

 

Die Lautstärke des linken und rechten Kanals ist getrennt regelbar. Auch eine Stummschaltung 
(Mute) ist möglich. 
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Wave (1/2 to 7/8) 

In der Wave-Abteilung wird die Lautstärke des abgespielten Signals eingestellt (für die Devices 
ADSP24 Ext.(n) WaveOut x/x). 

 

Stummschaltung für jeden Kanal ist möglich wie auch die getrennte Steuerung des linken und 
rechten Kanals. 

S/PDIF Out 

In der S/PDIF Out Abteilung wird die Lautstärke des Devices ADSP24 Ext. S/PDIF Out (n) 
gesteuert. 

 

Stummschaltung für jeden Kanal ist möglich wie auch die Pegel-Einstellung. 

S/PDIF In 

Diese Abteilung steuert den Pegel des am digitalen Eingang anliegenden Signals. 
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Stummschaltung für jeden Kanal ist möglich wie auch die Pegel-Einstellung. 

Input (1/2 to 7/8) 

Hier kann die Lautstärke für jeden Eingangskanal getrennt geregelt werden. 

 

Stummschaltung für jeden Kanal ist möglich wie auch die Pegel-Einstellung. 
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IX. Hardware Settings 

Wenn Sie auf Hardware Settings klicken, öffnet sich das Fenster für die Hardwareeinstellungen. 
Sie können die Samplerate in kHz (22, 32, 44.1, 48, 88.2 und 96 kHz), DMA-Puffer-Einstellungen 
und auch die Synchronisation (Internal oder External Master Clock) einstellen. 

 

Audio Data Handling 

Diese Funktion befähigt das System, selbst dann die gerade ablaufende Wiedergabe zu blockieren 
oder fortzusetzen, wenn eine bestimmte Konverter-Auflösung überschritten wird (i.d.R. 24bit). 

Clock and Sample Rates 

Diese Einstellungen legen die Samplerate fest, mit der das System arbeitet, und auch, ob ein 
externes Gerät das Timing kontrolliert. Die Audio DSP24 kann mit externen Geräten 
synchronisiert werden (External Master Clock) oder selbst für die Synchronisation sorgen 
(Internal Master Clock). Stellen Sie in jedem Fall sicher, daß alle Geräte mit derselben Samplerate 
arbeiten. Über Rate Locked kann festgelegt werden, daß die Anwendung die Samplerate nicht 
verändern darf. Bei Reset Rate After Play wird die Samplerate nach dem Beenden einer 
Anwendung wieder zurück gesetzt. 

Achtung: Bitte beachten Sie, daß Sie die Karte nicht verwenden können, falls kein Signal den 
S/PDIF-Eingang erreicht und gleichzeitig die Option External Master Clock aktiv ist. In diesem 
Fall kann die Karte weder aufnehmen noch abspielen – ohne einen maßgeblichen Qualitätsverlust. 
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Stellen Sie also bitte, bevor Sie eine Aufnahme beginnen, sicher, dass die Option Internal Master 
Clock aktiv ist. Nur falls Sie von einer S/PDIF-Quelle über die Tochterkarte XG DB I aufnehmen 
möchten, muß External Master Clock aktiv sein (i.d.R.). 

DMA Buffer Transfer Latency 

Diese Einstellungen regeln die Verzögerung (Latenz) bei Änderungen am System. Höhere 
Puffer-Einstellungen führen zu gesteigerter Latenz, aber zu geringeren Wahrscheinlichkeit von 
Dropouts bei Wiedergabe und Aufnahme. Geringere Puffer-Einstellungen führen zu geringerer 
Latenz, könnte aber eventuell zu Dropouts bei Aufnahme und Wiedergabe führen, da das System 
überlastet wird. 

Wenn Sie Knackgeräusche bei der Aufnahme- oder Wiedergabe bemerken, kann es sein, daß der 
Wert hier zu klein eingestellt ist. Wenn eine Veränderung der Einstellung nicht zum Erfolg führt, 
besteht mit großer Warscheinlichkeit ein Konfigurationsproblem bei dem verwendeten 
Computersystem. Bitte setzen Sie sich in einem solchen Fall mit dem Hersteller oder mit dem 
Hoontech-Support in Verbindung. 
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X. Anschluß an externe Geräte 

Die Audio DSP24 kann an eine Vielzahl anderer Geräte von Hoontech über das H-BUS Interface 
angeschlossen werden – auch eine interne Erweiterung (z.B. die XG DB I-Tochterplatine oder 
eine SoundTrack Digital Audio-Karte) ist möglich. Über External Links wird dies der Karte 
mitgeteilt. 

XG DB I 

Die XG DB I Anschlußplatine verfügt über digitale Ein- und Ausgänge (optisch und koaxal 
S/PDIF und AES/EBU). 

 

1+2. AES/EBU-Stecker. Zur Verwendung wird je ein XLR<->Miniklinke Adapter benötigt. 
3+5. Optische Ein-/Ausgänge. 
4+6. Koaxiale Ein-/Ausgänge. 
7. 4-pin Anschluß zur Verbindung mit der DSP24 Karte. 
8. CD-2-pin Digitaleingangsstecker digitale CD-ROM Signale. 
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Anschluß 

 

External Links Einstellung 

 

Sie können diese Verbindung über Inputs>Add Inputs>XG DB I herstellen. 

Achtung: Falls Sie eine virtuelle Verbindung von der XG DB I zum S/PDIF-Eingang herstellen, 
müssen Sie auch ein aktives Gerät an den koaxialen, optischen oder AES/EBU-Eingang 
anschließen (wie zum Beispiel ein DAT-Rekorder). Eine solche Verbindung stellt die 
Synchronisation von Internal Master Clock automatisch auf External Master Clock. um (siehe 
auch unter Abschnitt IX. HARDWARE SETTINGS). 

MK II Analog I/O Kabel 

Die Kabelpeitsche mit den 4 XLR-Anschlüssen für die DSP24 MK II sollte mit dem 15-pin 
D-SUB-Anschluß der Karte verbunden werden. 
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1+3. symmetrische Ausgänge (Output 1,2) 
2+4. symmetrische Eingänge (Output 1,2) 
5. Miniklinkenbuchse (Ausgang für Internal Mixer) 

External Links Einstellung 

 

Sie können diese Verbindung über Inputs>Add Inputs>MK II Input herstellen. 

Dieses Kabel steht bei der regulären Version der DSP24 nicht zur Verfügung. 

SoundTrack Digital Audio 

Wenn Sie über eine SoundTrack Digital Audio 4ch oder 16ch Karte verfügen, können Sie sie 
intern mit der DSP24 verbinden. 
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Anschluß 

 

Stecken Sie das Flachbandkabel so ein, daß das rot markierte Kabel an der Dreiecksmarkierung 
der Platine angebracht ist. Jetzt ist das Signal der SoundTrack Digital Audio-Karte im External 
Mixer Ihrer SoundTrack Audio DSP24 präsent. 

External Links Einstellung 

 

Sie können diese Verbindung über Inputs>Add Inputs>Digital Audio herstellen. 
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Externe Erweiterungen 

Bis zu vier externe Erweiterungen können gleichzeitig an eine DSP24-Karte angeschlossen 
werden. 

Anschluß 

 

Wenn Sie verschiedene externe Erweiterungen an dieselbe Audio DSP24-Karte anschließen, wird 
die erste so angeschlossen, wie in der obigen Abbildung gezeigt. Die zweite Erweiterung wird an 
den freien zweiten Datenanschluß der ersten Erweiterung angeschlossen und so weiter. 
Vergewissern Sie sich, daß jede Erweiterung eine eigene Nummer zugeteilt bekommen hat. Sie 
können diese Nummer einer externen Erweiterung mit den DIP-Schaltern auf der rechten Seite 
zuteilen. Vergeben Sie in jedem Fall diese Nummer, bevor Sie die externe Erweiterung in einem 
Rack festschrauben! 
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External Links Einstellung 

 

Wenn Sie einen ADC III oder ADC&DAC2000 Wandler verwenden (z.B.), dann wählen Sie den 
entsprechenden Eintrag unter External Links (also z.B. Inputs>Add Inputs>ADC&DAC2000). 
Bei allen anderen Geräten kann auch General Box verwendet werden. Stellen Sie sicher, daß die 
verwendete Box Number mit der realen Nummer übereinstimmt. 
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XI. Einsatz in Anwendungsprogrammen 

Für jede spezielle Anwendung, die Sie mit der Audio DSP24 einsetzen möchten, müssen Sie 
einige Konfigurationsschritte einhalten. Grundsätzlich kann gesagt werden, daß jeder 
Stereoeingangs- oder –ausgangskanal auf der Karte wie bei einer gewöhnlichen Soundkarte 
verwendet werden kann, wenn Sie die entsprechenden Devices verwenden. Normalerweise hat 
jedes Programm eine Konfigurationsfunktion, bei der Sie die Optionen für die jeweiligen Geräte 
auswählen können. 

Ein- und Ausgangsgeräte (Devices) 

Die möglichen Geräte für Aufnahme und Wiedergabe sind hier gelistet (“n” steht für die Nummer 
der installierten Audio DSP24 - normalerweise 1): 

• ADSP24 Int. WaveOut (n) – spielt Audiodaten über den Internal Mixer ab (die Sie dann über 
den Line-Ausgang der PCI-Karte anhören können). Bitte beachten Sie, dass dieser Treiber 
nur 16bit/48kHz als maximale Auflösung und Sample-Rate unterstützt. 

• ADSP24 Ext.(n) WaveOut 1/2 – das erste Stereo-Wavedevice. Verwenden Sie diesen Treiber, 
um Audio über die Ausgänge einer externen Erweiterung abzuspielen. Beachten Sie weitere 
Details im Abschnitt VII dieses Handbuchs. 

• ADSP24 Ext.(n) WaveOut 3/4 – das zweite Stereo-Wavedevice. Verwenden Sie diesen 
Treiber, um Audio über die Ausgänge einer externen Erweiterung abzuspielen. Beachten Sie 
weitere Details im Abschnitt VII dieses Handbuchs. 

• ADSP24 Ext.(n) WaveOut 5/6 – das dritte Stereo-Wavedevice. Verwenden Sie diesen 
Treiber, um Audio über die Ausgänge einer externen Erweiterung abzuspielen. Beachten Sie 
weitere Details im Abschnitt VII dieses Handbuchs. 

• ADSP24 Ext.(n) WaveOut 7/8 – das vierte Stereo-Wavedevice. Verwenden Sie diesen 
Treiber, um Audio über die Ausgänge einer externen Erweiterung abzuspielen. Beachten Sie 
weitere Details im Abschnitt VII dieses Handbuchs. 

• ADSP24 Ext. S/PDIF Out (n) – spielt Audiosignale über den -Digitalausgang (XG DB I) ab. 
Beachten Sie Abschnitt VII in diesem Handbuch für weitere Details betreffs des Routings der 
Ausgänge. 

• ADSP24 Multiple PCM Out (n) – das ist ein Interleaved-Treiber für das gleichzeitige 
Abspielen mehrerer Kanäle. Einige ältere Audioanwendungen verwenden diesen Treiber bei 
Mehrkanalkarten. 
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• ADSP24 Int. Record (n) – nimmt das Signal vom Internal Mixer auf. Verwenden Sie diesen 
Treiber, um über den Line-Eingang der Karte aufzunehmen. Bitte beachten Sie, daß dieser 
Treiber nur 16bit/48kHz als maximale Auflösung und Samplerate unterstützt. 

• ADSP24 Ext.(n) Input 1/2 – erstes Stereo-Eingangsdevice, mit dem Sie Eingangssignale von 
externen Erweiterungen aufnehmen können. Prüfen Sie Abschnitt X in diesem Handbuch, um 
zu lernen, wie Sie externe Erweiterungen verwenden. 

• ADSP24 Ext.(n) Input 3/4 – zweites Stereo-Eingangsdevice, mit dem Sie Eingangssignale 
von externen Erweiterungen aufnehmen können. Prüfen Sie Abschnitt X in diesem 
Handbuch, um zu lernen, wie Sie externe Erweiterungen verwenden. 

• ADSP24 Ext.(n) Input 5/6 – drittes Stereo-Eingangsdevice, mit dem Sie Eingangssignale von 
externen Erweiterungen aufnehmen können. Prüfen Sie Abschnitt X in diesem Handbuch, um 
zu lernen, wie Sie externe Erweiterungen verwenden. 

• ADSP24 Ext.(n) Input 7/8 – viertes Stereo-Eingangsdevice, mit dem Sie Eingangssignale von 
externen Erweiterungen aufnehmen können. Prüfen Sie Abschnitt X in diesem Handbuch, um 
zu lernen, wie Sie externe Erweiterungen verwenden. 

• ADSP24 S/PDIF In (n) – nimmt Signale vom S/PDIF-Eingang (XG DB I) auf. Prüfen Sie 
Abschnitt X in diesem Handbuch, um zu lernen, wie Sie die XG DB I Tochterplatine 
verwenden können. 

• ADSP24 Multiple PCM In (n) – das ist ein Interleaved-Treiber für das gleichzeitige 
Aufnehmen mehrerer Kanäle. Einige ältere Audioanwendungen verwenden diesen Treiber 
bei Mehrkanalkarten. 

• ADSP24 Digital Mixer (n) – mit diesem Treiber können Sie das Ausgangssignal des External 
Mixers aufnehmen. 

Zusätzlich verfügt die Karte über den ASIO-Treiber ADSP24 ASIO. Er ermöglicht einen Zugriff 
auf alle 10 Eingangs- und 10 Ausgangskanäle des External Mixers bei Anwendungen, die ASIO 
unterstützen (wie z.B. Cubase VST). ASIO erlaubt die Aufnahme und Wiedergabe mit einer sehr 
niedrigen Latenz (bis zu 3ms). So können Sie beispielsweise Softwaresynthesizer in ‚Echzeit’ 
spielen. 

Bitte beachten Sie, daß die meisten Anwendungen spezielle Einstellungen erfordern, wenn sie mit 
der SoundTrack Audio DSP24 zuverlässig und korrekt arbeiten sollen. Selbstverständlich testen 
wir die Karte laufend mit den unterschiedlichsten populären Anwendungen. In den folgenden 
Abschnitten haben wir einige Beispiele für einige dieser Programme für Sie zusammengestellt. 
Nehmen Sie sich bitte die Zeit, sich diese jetzt genau zu betrachten – damit vermeiden Sie später 
Probleme. Sollten dennoch Probleme auftreten, oder sollten Sie andere Programme verwenden, 
empfehlen wir Ihnen, Hoontech zu kontaktieren, wozu Sie am besten das Q&A-Support-Forum 
im Internet nützen (http://www.hoontech.com). 
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Der Einsatz von Emagic Logic SoundTrack24 

Logic SoundTrack24 ist eine spezielle Version der Logic Software aus dem Hause Emagic, die 
speziell an die Audio DSP24 Karte angepaßt wurde. Der Zugriff auf die Audiohardware erfolgt 
entweder über den ASIO- oder den MME-Treiber der Audio DSP24 für die Aufnahme und 
Wiedergabe. 

• Öffnen Sie File>Hardware settings in External Links. 

 

• Wählen Sie die ASIO-Puffergröße: Wir empfehlen einen Wert von etwa 1800 – abhängig von 
der Systemleistung. 

• Stellen Sie sicher, daß die Option Rate Locked ausgeschaltet ist. 

• Setzen Sie die Option MultiTrack Wave Drivers auf Independent 

• Starten Sie Logic SoundTrack24 und wählen dort Audio>Audio Hardware & Drivers. 
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• Wählen Sie Audio Drivers um dann ASIO ADSP 24 als ASIO-Gerät einzustellen. Soll mit 
24bit-Auflösung gearbeitet werden, stellen Sie sicher, daß die Option 20/24 Bit Recording 
aktiviert ist. 

• Wenn Sie den MME-Treiber verwenden möchten, wählen Sie einen dieser Einträge: 

MME ADSP24 10ch/24bit – Aufnahme und Wiedergabe mit 24bit auf allen Kanälen 
MME ADSP24 10ch/16bit – Aufnahme und Wiedergabe mit 16bit auf allen Kanälen 
MME ADSP24 Digital/24bit – Aufnahme und Wiedergabe über Digital I/O bei 24bit 
MME ADSP24 Digital/16bit – Aufnahme und Wiedergabe über Digital I/O bei 16bit 

• Beenden Sie Logic und starten es nochmals um die Einstellungen zu aktivieren. 

Bitte beachten Sie ebenfalls die Dokumentation von Logic SoundTrack24. 
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Der Einsatz von Steinberg Cubase VST/24 3.72 

Cubase VST 3.72 aus dem Hause Steinberg verwendet ASIO-Treiber, um die Audiohardware zu 
nutzen. Steinberg hat ASIO als Standard implementiert, um die Unterstützung für mehrkanalige 
Aufnahme und Wiedergabe zu verbessern. Über ASIO-Treiber können auch niedrigere 
Latenzzeiten erreicht werden – ein Feature, das vor allem beim Einsatz von VST-Instrumenten 
wichtig ist. Bitte beachten Sie, daß die Einstellungen bei anderen Steinberg-Programmen (wie 
z.B. Nuendo, Cubasis VST, Cubase VST 5.0) nahezu identisch sind, sofern der ASIO-Treiber 
eingesetzt wird. Bitte beachten Sie diese Einstellungsschritte: 

• Öffnen Sie File>Hardware settings in External Links. 

 

• Wählen Sie die ASIO-Puffergröße. Bei schnelleren Systemen (Pentium III, Athlon) können 
Sie in der Regel problemlos auch die kleinste Einstellung auswählen. Dadurch wird die 
Latenzzeit auf 3ms festgelegt (bei 96kHz, 7ms bei 48kHz und 8ms bei 44.1kHz). Bei anderen 
Systemen können Sie diese Einstellung probieren und später – je nach Performance – den 
Puffer erhöhen. 

• Starten Sie Cubase VST und wählen dann Audio>System. 
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• Unter Audioleistung, sollte Anzahl der Kanäle auf 16 eingestellt werden. 

• Unter Monitoring wählen Sie bitte Global ausgeschaltet (Empfehlung). Wenn Sie Signale in 
Echtzeit mithören und gleichzeitig VST-Effekte einsetzen möchten,. Wählen Sie 
Bandmaschinenmodus. 

• Hinter ASIO Gerät wählen Sie ADSP24 ASIO. Über ASIO Systemsteuerung, können Sie auch 
die Puffergröße einstellen. 

• Darunter wählen Sie die gewünschte Samplerate. 

• Wenn das Echtzeit-Monitoring der Audio DSP24 verwendet werden soll (ohne den Einsatz 
von VST-Effekten auf eingehende Audiosignale), aktivieren Sie ASIO direktes Mithören. 
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Um die zu verwendenden Ein- und Ausgänge innerhalb von Cubase VST festzulegen, öffnen Sie 
Audio>Eingänge. Ein Fenster erscheint, in dem Sie die jeweiligen Eingänge (in Stereopaaren) 
ein- und ausschalten können. Im VST Channel Mixer (über Audio>Monitore) können diese den 
Spuren zugewiesen werden. Für die Ausgänge müssen Sie die Funktion Audio>Master aufrufen. 
Im erscheinenden Fenster können Sie für jeden Stereo-Ausgang ein Bus aktivieren. Diese Busse 
können innerhalb von Cubase VST verwendet werden, um Signale zu den Ausgängen individuel 
zu routen. Weitere Informationen finden Sie in der Dokumentation von Cubase VST. Die 
neuesten Updates für Cubase VST bekommen Sie im Internet unter http://www.steinberg.de. 
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Der Einsatz von Emagic Logic Audio Platinum 4.5 

Der leistungsfähige Audio-/MIDI-Sequencer Logic Audio Platinum 4.5 (und höher) von Emagic 
verwendet ebenfalls die ASIO-Schnittstelle. Beachten Sie diese Einstellungsschritte: 

• Öffnen Sie File>Hardware settings in External Links. 

 

• Stellen Sie nun die ASIO-Puffergröße ein. Wir empfehlen einen Wert von 800 oder höher – 
natürlich abhängig von der Systemperformance. 

• Starten Sie Logic Audio Platinum und wählen dann die Option Audio>Audio Hardware & 
Treiber>Audio Treiber 2. 
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• Aktivieren Sie die ASIO-Checkbox und wählen ASIO ADSP24 als ASIO-Gerät. Soll mit 
24bit-Auflösung gearbeitet werden, stellen Sie sicher, daß die Option 20/24 Bit Recording 
aktiviert ist. 

• Starten Sie Logic Audio neu um die Einstellungen zu aktivieren. 

Das neueste Update für Logic Audio Platinum bekommen Sie unter http://www.emagic.de. Für 
alle Logic 4.xx Versionen empfehlen wir mindestens den Einsatz der Version 4.5 (oder höher). 
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Der Einsatz von Cakewalk 9.x 

Cakewalk ist ein beliebter Audio-/MIDI-Sequencer. Das Programm verwendet die MME-Treiber 
der SoundTrack Audio DSP24. 

• Starten Sie Cakewalk und wählen Options>Audio. Der DirectShow Audio Dialog erscheint. 

  

• Klicken Sie auf Drivers. Nun erscheint die Liste der verfügbaren MME-Geräte für die Ein- 
und Ausgänge. Wählen Sie alle Einträge, die Sie nutzen möchten (beachten Sie dazu den 
Abschnitt EIN- UND AUSGANGSGERÄTE (DEVICES) in diesem Kapitel). 
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• Wählen Sie jetzt General und anschließend Wave Profiler. Folgen Sie den Anweisungen am 
Bildschirm, bis die Nachricht Audio hardware has been successfully profiled erscheint. 

• Wählen Sie ADSP24 Ext.(n) WaveOut 1,2 als Playback Timing Master und ADSP24 Ext, (n) 
Input 1,2 als Record Timing Master. Wenn Sie vom S/PDIF-Eingang aufnehmen, wählen Sie 
stattdessen ADSP24 S/PDIF In (n). Die Option Audio Driver Bit Depth sollte auf 24 stehen. 

• Wählen Sie die Samplerate und Auflösung, mit der Sie arbeiten möchten, unter Default 
Settings for New Projects. 

• Mixing Latency: Grundsätzlich sollte Buffers in Playback Queue auf 4 stehen. Ein kleinerer 
Wert als 4 ergibt eine kleinere Latenzzeit, aber die Performance könnte dadurch schlechter 
werden. Wählen Sie als erstes den vorgeschlagenen Wert aus dem Effective latency Test – 
i.d.R. ca. 100msec. Wenn der Wert geringer sein soll, wählen Sie Advanced und aktivieren 
Sie WavePipe(TM) Acceleration. Bedenken Sie, daß jedes System leicht unterschiedliche 
Einstellungen benötigt. Es empfiehlt sich, mit den Einstellungen etwas zu experimentieren, 
bis sie optimal sind. 

• Unter Device Profiles sollte die Option Use Wave Out Position For Timing aktiviert sein. 

Die neuesten Updates und Hinweise zu Cakewalk gibt es unter http://www.cakewalk.com. 
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Der Einsatz von Traktor von Native Instruments 

Traktor ist eine professionelle DJ-Mixing Software aus dem Hause Native Instruments mit der 
Möglichkeit für die Wiedergabe von CD, Wave-Audio oder auch von MP3-Daten. Am besten 
lohnt sich der Einsatz des ASIO-Treibers der DSP24. 

• Öffnen Sie File>Hardware settings in External Links. 

 

• Wählen Sie die ASIO Puffergröße. Wir empfehlen den Wert 1800 oder niedriger – abhängig 
von der Systemleistung. 

• Starten Sie Traktor und wählen den Setup>Audio Dialog. Wählen Sie am unteren Ende des 
Fensters den ASIO Treiber ASIO ADSP24 für die Wiedergabe. 

Die aktuellen Info’s zu Traktor gibt es im Web unter http://www.ni-traktor.com. 
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Der Einsatz von Nemesys GigaSampler 1.6 

Der GigaSampler von Nemesys ist ein besonders leistungsfähiger und beliebter Softwaresampler. 
Die SoundTrack Audio DSP24 bietet einen speziellen GSIF-Treiber (GigaSampler-InterFace) der 
die mehrkanalige Wiedergabe aus GigaSampler ermöglicht. 

• Starten Sie GigaSampler und wählen Config>Outputs. 

  

• Unter Wave Out Driver, wählen Sie Audio DSP24 MultiChannel Driver. 

• Nun können Sie die einzelnen Kanäle rechts unter Outputs Enabled aktivieren. 

• Unter Midi Channels mapped to Outputs können Sie die MIDI-Kanäle den Ausgängen 
zuordnen. 

Die aktuellen Informationen zu GigaSampler finden Sie auf der Nemesys-Webseite: 
http://www.nemesysmusic.com. 


